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Before you get too confused by the title of this paper, I’d better explain the terms I’m 
using.  By CW, I mean International Morse using a CW tone; and by Morse, I mean 
American Morse on a telegraph sounder.  The aim of this course is fluency in 
conversational Morse, by which I mean the ability to recognize ordinary, everyday words 
and phrases by ear, rather than writing down each letter by hand.

The KOB Morse Course takes advantage of learning features provided by the Morse 
KOB program.  For information about the KOB program, please visit 
www.morsekob.org.

This course assumes you’re already comfortable copying CW at, say, 20 or 25 wpm.  If 
you’re not that fast at CW yet, don’t despair!  The KOB Morse Course can help raise 
your CW code speed at the same time as you’re learning Morse.

 “But will learning American Morse affect my CW ability,” you ask?  Good question!  
The short answer is, “Maybe.”  No controlled studies have been carried out, to the best of 
my knowledge, so all the evidence is anecdotal.  Certainly there are many examples of 
operators who are equally proficient at both codes.

I can tell you what my own experience has been.  Now that I’ve become reasonably 
fluent in Morse, I do have a tendency to make occasional sending errors in CW.  More 
often, this tendency manifests itself as a slight hesitation, rather than an actual error.  I 
can always avoid this problem by thinking more carefully about my sending.

The good news is that the confusion factor has not been as issue for me when copying 
CW, and in fact my ability to copy International Morse has actually improved as a result 
of learning the American code.  Why this should be I can only guess.  It might be because 
I used better learning methods the second time round, and my proficiency in Morse had a 
spillover benefit in my ability to copy CW.

Many operators who are skilled in both codes recommend using International only with a 
CW tone and American only with a sounder.  That way, it may be easier to keep the two 
codes straight in your mind.

The philosophy
A fundamental premise of the KOB Morse Course is that you’re learning Morse for fun.  
You’re not planning a career as a professional telegrapher; such jobs are scarce nowadays 
anyway.  You just want to chat informally in Morse, perhaps using the Morse KOB 
system over the Internet.

As already mentioned, I also assume that you’re familiar with CW – maybe you’ve used 
it on the ham bands – and you’d like to use that knowledge as a springboard to become 
proficient at Morse.
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I’m a big fan of the Koch and Farnsworth methods.  I’m not a fan of tedious code 
practice sessions where you copy strings of random characters.  Repetition definitely is 
important while you’re learning the code, but boredom is the student’s worst enemy.

I believe you should pick your target speed and start learning at that speed from the very 
beginning: 20 wpm minimum, 25 would be better.  I also believe you should be copying 
real words sent at full speed right from the start.  How this is possible is addressed in the 
following sections.

When I talk about “copying”, I really mean reading Morse in your head, the same way 
you’d listen to a conversation rather than writing down a transcript of the conversation 
like a stenographer.  It’s much more pleasant to learn while you’re relaxed and with your 
eyes closed, instead of being tense and gripping a pencil in your hand.

Step 1: Getting used to the sounder
To the experienced CW operator, the clicks and clacks of a sounder can be totally 
incomprehensible at first.  With surprisingly little practice, however, the sounder will 
seem just as natural as a tone.  To help make the adjustment, you can start by listening to 
a tone and sounder simultaneously.  It’ll sound like CW with a serious case of key clicks, 
but you should be able to copy it easily enough.  Then you can drop the tone and use the 
sounder alone.

Exercise 1a: CW tone only

1. Set the WPM setting on the main KOB window to your normal CW code speed or 
20 wpm, whichever is greater.1

2. Open the Preferences window by clicking on the Tools menu and selecting 
Preferences, or by pressing Ctrl-P.

3. Set Internal Sounder to Tone.

4. Set Repeat Group to Word and Times to 2.  This causes each word to be sent 
twice.

5. Set Farnsworth Type to Word and Space to 300.  This adds an extra 300 ms to 
the space between words.

6. Click on the OK button.

7. Click on the File menu and select Open, or press Ctrl-O.

8. Select the Getting started file and click on the Open button.

9. Start the code sender by pressing the Pause button on the keyboard.

You will hear some common English words – the, and, a, in, that, it, and is – sent at the 
selected code speed using a CW tone.  Each word is sent twice, with a pause between 
each word (the “Farnsworth” space).  Do you find it easy to copy?  Good, then run the file 
again at a higher speed.2  Keep increasing the code speed until you can copy most of the 
words when they’re sent the first time.  You should be doing this in your head, not writing 
anything down.

                                               
1 You may want to have two copies of the KOB program on your computer, one with preference settings 
for using the program with the KOB server on the Internet and a separate one set up just for code practice.
2 You can press Pause to stop the code sender, Home to reset the sender’s cursor to the beginning of the 
file, and Pause again to restart the sender.  The code speed can be increased by pressing function key F5, or 
reduced by pressing F4.
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Exercise 1b: Mixed tone and sounder

1. Open the Preferences window (Ctrl-P) and change the Internal Sounder setting 
to Mixed.  Click on the OK button to close the Preferences window.

2. Set the code speed to the target speed you established in Exercise 1.

3. Listen to the Getting started text again, just like you did in the previous exercise.

This time you’ll hear the clicks and clacks of a sounder along with the CW tone.  It should 
be just as easy to copy as it was before.  If not, spend some time with it until you get 
used to it.

Exercise 1c: Sounder alone

1. Open the Preferences window again and change the Internal Sounder setting to 
Normal.

2. Set the Code Sender Loop checkbox on the main KOB window to cause the text 
to be sent over and over again repeatedly.

3. Listen to the Getting started text once again, still at your target code speed.

Spend as much time as you need with this exercise.  Sooner or later, the sounder 
becomes second nature and is just as easy to copy as a CW tone.

Step 2: Reviewing the familiar letters
More than half the letters of the alphabet – 15 of them, to be exact – are exactly the same 
in the American and International codes.  These letters are e, t, a, i, n, s, h, d, u, m, g, w, 
b, v, and k (in decreasing order of frequency in the English language).

Many common words can be formed from these 15 familiar letters.  Starting with just the 
first six letters, for example, there are words such as at, in, eat, tin, ate, seat, and stain.  
An effective way of reviewing these letters – or relearning them, as the case may be – is 
to listen to words sent at your full target code speed right from the beginning.  Rather 
than writing them down, just listen to them and see if you can recognize them.  Having 
the program repeat each word two or three times and adding extra space between the 
words will make it a lot easier.

Exercise 2: The familiar letters

1. Set your KOB preferences for word repetition x2 and 300 ms word Farnsworth 
spacing, as in the previous exercise.

2. Open the Lesson window by clicking on the File menu and selecting Lesson, or 
by pressing Ctrl-L.

3. Set the Level to 6.  This will produce words consisting of six of the most common 
letters in the English language: e, t, a, i, n, and s.  Click on OK to generate the 
lesson.

4. Press the Pause button on the keyboard to start the code sender.

If you feel overwhelmed at first, try a longer word Farnsworth setting on the Preferences 
window, or perhaps more word repetitions on the Lesson window.  Try to resist the 
temptation to lower the code speed.

When you can recognize most of the words the first time they’re sent, and the repetition 
just confirms that you got them right, then go from level 6 to level 7, and so on, until you 
reach level 15.
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If one or two letters are causing you particular trouble, then you can enter those letters 
into the Required Letters field in the Lesson window.  That will force the lesson to contain 
only words that contain at least one of those “problem” letters.

If your target speed for Morse is about the same as your current code speed in CW, this 
step should go fairly quickly.  There’s no reason why you shouldn’t use this as an 
opportunity to increase your code speed, however, and if you’re like me you’ll find that 
this kind of practice with American Morse on a sounder will have immediate benefits for 
your CW copying ability.

Step 3: Adding some new letters
The letters o, r, l, c, y, and z have a unique sound in Morse that’s not like anything you’ll 
hear in CW.  The letter r, for example, sounds like dit-didit, with a short space between 
the first dot and the next two, while the letter l is daah, a dash that’s longer than a t.

The process for Step 3 is identical to Step 2, although it probably won’t go as quickly.  
When you do finish Step 3, however, you’ll be able to recognize words formed from 21 
of the 26 letters of the alphabet at your full target code speed.

Exercise 3: The “Morse” letters

1. Use the same Preferences settings as for the previous exercise.

2. Press Ctrl-L to open the Lesson window.

3. Set the Lesson to 16.  This adds the letter o to the mix.

4. Type the letter o in the Required Letters field.  This will cause each practice word 
to contain an o.

5. Click on the OK button to generate the lesson.

6. Press the Pause key to start the lesson.

Once you’re comfortable with the letter o, go from level 16 to level 17, and so on until 
you’ve done Level 21.

If one or two of these new letters are causing you trouble, then concentrate on copying 
words that contain those letters.  For example, if you find you’re getting c and r confused 
(I sure did at first), then concentrate on words that contain those letters – such as there, 
core, race, etc. – by specifying c and r as required letters.

By the time you’re done with Step 3, you’ll be well acquainted with the unique sound and 
rhythm of American Morse.

Step 4: Tackling the “false friends”
You still have five more letters to learn to round out the alphabet.  These letters are f, p, x, 
j, and q, and I call them the “false friends” because their sound in American Morse means 
something different in International.  The more familiar you are with CW, the more of a 
problem this can be.  

Fortunately, x, j, and q are among the least frequently used letters in the English language 
(along with z), so their potential confusion with l, c, and f tends not to be a serious 
obstacle in following a normal conversation in Morse.  Similarly, even though the letter p
sounds like the numeral 5, that shouldn’t cause too much confusion either.
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If you’re like me, though, you’re going to have a terrible time getting used to the idea that 
didahdit in Morse is f and not r.  The frequency of the letter f in such common words as 
of, for, if, and from means that you’re going to run into this problem all the time.  The 
good news is that this also gives you plenty of practice to help you get over the problem.

To confront this issue head on and get past it as quickly as possible, you can use the KOB 
program to generate code practice sessions only using words that contain the letter f.

Exercise 4: the “F” words ☺

1. Open the Lesson window by pressing Ctrl-L.

2. Set the Level to 26.

3. Type the letter f into the Required Letters box.

4. Click on the OK button to generate the lesson.

5. Press the Pause key to start the lesson.

Step 5: The finishing touches
If you’ve made it this far in the KOB Morse Course, then undoubtedly you’re already 
communicating with other operators in Morse using the KOB system over the Internet, or 
maybe even using one of the dialup hubs.  Most likely you already know what else you 
want to learn about American Morse and how to go about learning it without any further 
help from me.

For completeness, however, I’d like to touch on four remaining topics: punctuation, 
numbers, “phrasing”, and abbreviations.

Punctuation

As this paragraph demonstrates* even though a period in Morse sounds like a question 
mark in CW* a question mark sounds like a slash* and a comma has no equivalent in 
CW* you dont really need to know the punctuation in order to follow the conversation?  
As long as you dont get hung up when you hear a long string of dots and dashes* the 
meaning will be clear from the context?  Dont you agree/

So I wouldn’t spend a lot of time in formal practice with punctuation.  The only ones in 
common use are the period (.), comma (,), question mark (?), and paragraph separator (=).  
In spite of the fact that the period sounds like a question mark at first, and the question 
mark like a slash, you’ll quickly get used to them.

Numbers

You already know one of the numerals: 4.  The others you’ll have to learn from scratch.  
Unfortunately, some of them turn out to be “false friends” – especially 8, which sounds 
like 6 in International.

How quickly you learn the numbers in Morse will depend largely on your motivation and 
patience.  And you can always fall back on the KOB program’s code reader to help copy 
numbers that are sent over the wire.
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“Phrasing”

Morse sent by experienced operators tends to be sent with slightly shorter word spacing 
than standard CW.  If you’ve been using the “word Farnsworth” method for learning 
Morse, however, your ear has become accustomed to hearing a prolonged space between 
words.  Because of this, you may get in the habit of sending Morse with too much space 
between your words.

To help overcome this tendency, the KOB program has an option of sending code with 
“phrase Farnsworth” spacing instead of character or word spacing.  With this option, the 
extra spacing is inserted between phrases, where for this purpose a phrase is delimited by 
two consecutive spaces in the text.

Exercise 5: “Phrase” Farnsworth

1. Press Ctrl-P to open the Preferences window.

2. Set Repetition Group to Phrase and Times to 2.

3. Set Farnsworth Type to Phrase and Space to 300.

4. Click on OK to close the Preferences window.

5. Press Ctrl-O to open the file browser dialog box, select the Beaufort scale file, 
and click on the Open button.

6. Press the Pause key to start sending the text.

By using the “phrase Farnsworth” method, you’ll get used to hearing letters and words 
sent at their natural pace, but you still get occasional breaks in the code stream to give 
your brain a chance to catch up and reset.  

Phrase Farnsworth is still an experimental concept.  Whether it should be used from the 
very beginning of the course, as an advanced feature at the end, or not at all is an open 
question.  Feedback from you, the student, will be very much appreciated.

Abbreviations

If you’ve used CW on the ham bands, then you’re already familiar with the use of 
abbreviations.  Landline telegraphers also made extensive use of abbreviations, and 
you’ll still hear these traditional abbreviations in use on the KOB wires and on the dialup 
hubs.

Many of the landline abbreviations will sound familiar to you: vy, gud, 73, etc.  Others, 
like gg for going, tt for that, and smg for something, may take some getting used to, but 
the meaning should be clear from the context.  Some common ham abbreviations, on the 
other hand, such as fb, om, xyl, and Q signals like QTH and QSO, are rarely heard on the 
wire.  You’ll often hear tks instead of tnx, and the traditional wire code 30 is used as a 
substitute for SK or QRT.

TKS ES 73
LES AT SO OFC
30


